2 CHAPTER: IRMS INTRODUCTION AND NAVIGATION

2.1

2.1.1

Overview of IRMS

To enhance its ability to work effectively and provide the best possible service to taxpayers, the
Virginia Department of Taxation (TAX) uses an Integrated Tax and Revenue Management System
(IRMS). IRMS is a software suite for tax and revenue management that supports taxpayer
registration, tax return processing, and taxpayer and revenue accounting to provide an integrated
processing solution for all major tax types. You will be using a Web version of IRMS to access
taxpayer and tax return information.

How IRMS Organizes Information

Once you are successfully logged into IRMS, you can begin to view information about taxpayers.
Some of the information you will have access to include:

m  Customer Profile listing demographic information about the taxpayer.
m  Bank Account information to include bank account, routing and transit numbers.

m  Tax Account information for Individual, Fiduciary, Corporate Income, Withholding, and Sales
and Use tax types.

m  Business Location information to include demographic, locality, and associated tax account
information.

m  Tax Account Period information for each tax account. Returns are associated with a Tax
Account Period.

m  Tax returns, which include return type, return status, Submitted/Processed dates, amount, line
item entries, and adjustments.

m  History information for all available years in the system.

&Note: Not everyone will be able to see exactly the same information. The details of your
agency's MOU determine what taxpayer information you can access. Some kinds of information
are secured. This means you need special levels of authorization to view or change it, but the
information you need for your daily work is readily available to you.

ﬁNote: Based on your agency’s MOU, you can access individual taxpayer information regardless
of locality, and you can view information (such as Corporate Income or Withholding Tax Account
entries) about business taxpayers in your locality and up to 20 adjacent localities. In addition, if a
business taxpayer has a Sales Tax or Use Tax account, you can view Customer Profile, bank account,
business location, and Sales or Use tax account information for that customer regardless of locality,
provided your MOU allows it.
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2.2 Getting Started

2.2.1 Starting a Session — First Login

IRMS is an online application, which is accessible by navigating to the External Web Applications
page on the TAX web site and logging into the application. After entering your login information, the
Duo Security (Duo) application validates your credentials before IRMS opens.

Step 1:  Enter the following web address into your browser, or click the link below:
www.tax.virginia.gov/external

The Virginia Department of Taxation External Web Applications page opens.
Step 2:  Click the Log on to IRMSWeb link on the page.
After clicking the IRMSWeb link on the web site, the IRMS Login window opens.

IRMS Login

User ID:

Password:

OK Cancel

Step 3:  Enter your User ID and Password into the applicable window fields.
Step4: Click OK.
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https://www.irms.tax.virginia.gov/VTOL_ARWeb/

Password Change

The first time you log into IRMS, or whenever your password is reset, the application
prompts you to change your password.

IRMS Login

User ID:

Password:

Mew
Password:

“erify
Password:

Change Password

OK Cancel

When creating a new password, the following criteria must be met:
1. Passwords need to be 8 to 16 characters long.
2. Passwords must contain at least three of the following four items:
e Alphabetical characters
e Numeric characters
e Special characters
e Combination of upper case and lower case letters
3. Passwords with spaces are not allowed.
4. A previous password can be reused after using 24 additional passwords.
After entering and verifying the new password, click OK.

In addition to the first-time login, you can also choose to change your password at any time.
See Change Password for the steps for creating a new password.
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2.2.2 Duo Login Credentials Authentication

Each time you enter your User 1D and Password into IRMS, the Duo application launches and generates
a call to your registered telephone number.

What is this?
Add a new device
My Sefiings & Devices

Heed help?

Step 1:  Perform one of the following options when you receive a call from Duo:

e Press any number on your phone to authenticate your credentials.

¢ Hang up if you did not attempt to login to IRMS, preventing any unauthorized

access.

When authenticated, the IRMS Desktop opens and the following pop-up windows appear

sequentially.

from web ’

Message from webpage ‘ ﬂ

L\ ‘You are running against TARXPRCD

et ) _

I |

NOTICE and WARNING: This computer system is the property of the
Commonwealth of Virginia and may contain U.S. Government
information. Access to this system is restricted to authorized users only!
Unauthorized access, use, misuse, or modification of this computer
system or of the data contained herein or in transit to/from this system
constitutes a violation of Title 18, US Code, Section 1030, and may
subject the individual to Criminal and Civil penalties pursuant to Title
26, US Code, Sections 7213, 7213A (Taxpayer Browsing Protection Act),
and 7431, as well as under applicable Virginia Law (Code of Virginia
18.2). This system and equipment are subject to monitoring to ensure
proper performance of applicable security features or procedures. Such
monitoring may result in the acquisition, recording, and analysis of all
data being communicated, transmitted, processed, or stored in this
system by a user. ANYONE USING THIS SYSTEM EXPRESSLY CONSENTS
TO SUCH MONITORING!! If monitoring reveals possible evidence of
criminal activity such evidence may be provided to law enforcement
personnel. Unauthorized or improper access or use of this computer
system and/or the data contained therein also may subject the
individual to disciplinary action, including termination, under your
employer's personnel policies, procedures, and guidelines. By
proceeding to logon you hereby acknowledge that you have read, fully
understand and comply with this WARNING, as well as TAX's access,
communication, and security policies.

Step 2:  Click OK to close each pop-up and to begin using the IRMS Desktop.
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UPDATING DUO

If your telephone number changes, you will need to submit an IRMS Authorization Request
Form (SA-IRMS-E) to Virginia Tax to have your user profile updated with the new telephone
number. The SA-IRMS-E form can be downloaded from the Virginia Tax web site and
includes instructions for submitting the form to Virginia Tax.

If Duo is unable to authenticate your credentials, the window below appears.

Access Denied. The username you have entered cannot authenticate with Duo

Security. Please contact your system administrator.

Call the VITA Customer Care Center (VCCC) at 866-637-8482 to resolve any access issues,
or any Duo login problems you may have.

Additional Information

If you didn’t select the Remember me for 10 hours checkbox during enroliment and decide
later that you do want to use this feature, follow the steps below:

Step 1:  Login to IRMS. After login, Duo launches.

Dialing XXX-XXX-4026... Cancel

Step 2:  Click the Cancel button at the bottom of the window.
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What is this? Of

Need help?

Choose an authentication method

Q@ Call Me

Call Me

Bypass Code / Enter a Bypass Code

%

Remember me for 10 hours

Step 3:  Click the Remember me for 10 hours indicator.

Step 4:  Click Call Me to resume authenticating your credentials.
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2.2.3 IRMS Main Window
After you have successfully logged into IRMS, you will see the IRMS Main window. All of your

work in IRMS will originate from this window.

The contents of this window include:

Title Bar identifies which window you have accessed and includes the standard windows

resizing buttons.

Menu Bar lists the pull down menus that are used to access IRMS windows. The menus

displayed on the Menu Bar may change depending on which IRMS window is active.

You can display the contents of each window by clicking on the menu and choosing an
item from the pull-down boxes.

Display Area contains the specific window you have accessed. The illustration below is

the IRMS Main window.

File

‘K| Tax Information

“| Help

Title bar

Menu bar

Display Area

I

The IRMS Main Menu Bar

The Menu Bar contains three menus: File, Tax Information, and Help. To access the information in

IRMS, you must choose an activity from one of these menus.

ﬁNote: Depending on your role, the menus shown in the illustration above may vary.
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The illustration below is the IRMS Main window — File menu. The File menu provides you the
ability to print or close the current window, and to exit IRMS.

" IRMS [_[ox]
File | Tax Infarmation | Help | j‘
Close
Print
Euxit

[

The illustration below is the IRMS Main window — Tax Information menu.

ENote: Depending on your role, you may not have all of the menu selections shown in the
illustrations below.

% IRMS - [o]x]

l File *| Tax Information ‘| Help I =
Customer Search...
P and | Calculator...

Accelerated Return

Local Uncollectible
Setoffs...

Locality Pending Transfer
in Progress

|
This is the menu that you will use most often to navigate in IRMS and access information.
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The illustration below is the IRMS Main window — Help menu. The Help menu provides on-line

help on IRMS topics.

| File

: | Tax Infarmation

Help

Help Topics...
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2.2.4 IRMS Windows

After you have selected an item from one of the menus on the Main window, you will view an IRMS
window displaying the information you selected. There are several different types of windows in

IRMS. The types of windows include:

List - These windows display lists of items that you can select to view additional information.

You highlight an item on the list to view a Detail window.
Detail - These windows contain fields for you to view, enter, or change information.

Pop-up - These windows are intended to make you aware of the consequences of your actions.
Most often, they either remind you of what you have done, or ask for a confirmation that you
have done what you intended. These message boxes and error messages are discussed in the

appropriate chapter(s).

The illustration below is an example of a List window:

| File | Tax Account : | Help : |

Tax Account List - XYZ CORP

Tax Type Tax Account Stars Legacy Number |Stars Combined Current Filing
Legacy Number Frequency

Sales and Use 10541111 111F001 Marthly

Withholding 30541111 111F001 hMonthly

The illustration below is an example of a Detail window:

| File I Customer l Help J :IL

Customer

$S§N: [222-22-3332 Entity Type: Irndividud

Name: |DOE, JOHN

Street: [600 EAST MAIN STREET

[

City: |RICHMOND | state: |[va ~|
Zip: [23223 ™ undeliverable
Close
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The illustration below is an example of a Pop-up window.

AI

IRMS Login

‘ User ID: I

WWarningl IRMS cannot locate the passwaord pou entered,
Flease ty again.

oK I Cancel |

Change Pazsward I
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2.3 Ending a Session
To end an IRMS session, you must return to the IRMS Main Window.

Step 1:  From the File menu, select the EXit option. You receive a system prompt pop-up window
asking you to confirm the exit.

*» IRMS

- [ofx
File | Tax Information *| Help '] =
Close
Print
Exit
=

A pop-up window asks you to confirm the exit.

Microsoft Internekt EHpr x|

@ Are wou sure you wank ko quit?

oK I Cancel |

Step 2:  Click OK to exit IRMS.
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